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Hello, this is Eric Bobrow. And in this ArchiCAD tutorial training, we'll take a look at how you can use
keyboard shortcuts to speed up your work as well as certain special mouse clicks. Now in ArchiCAD,
there are many ways to do things. If | select this column and | would like to drag a copy of it, | can go to
the Edit menu, Move, Drag a Copy, then click and click. Or, | can, with it selected, right click and say
Move, Drag a Copy from the context menu and do the same thing: click, click. [0:00:32]

Or, | can just start to drag with the Arrow tool and press and release the Option key on the Mac or the
CTRL key on Windows to get the little plus that indicates that it's a copy, and then click again. An in fact,
if | don't have it selected, | can just press and start to move it with the Arrow tool that will start the drag,
and then press and release that modifier key, Option or CTRL, to create a copy. So many different ways
to doit. [0:00:59]

Now the general philosophy that | follow, and | recommend you consider, is that things that seem
awkward to you or that you do repeatedly, take the time to learn the quicker way to do it. So in other
words, if you find that going up to the Edit menu is tedious, and certainly it is a little bit inconvenient,
see if when you right click you will have something in the context menu that has the same Command.
And if you find that still a little bit extra tedious, then see if you can learn the keyboard shortcut or the
more direct gestures that have the same effect there. [0:01:35]

Now there are some Commands that you can use in a variety of ways, but they do not have a keyboard
shortcut. So for example, if | would like to take these two walls and intersect them, | can go to the Edit
menu, Reshape, Intersect; and you'll see there's no keyboard shortcut. So | have to take the time to go
up to that menu Command. Or, and | will just undo this, | can use the toolbar shortcut that says
Intersect. In fact, | use that all the time. [0:02:04]

But if you would prefer to have a keyboard shortcut for it, let's go to the Options menu and look at Work
Environment, Keyboard Shortcuts, where we can see and add to the keyboard shortcuts. So for
example, that Command was under the Edit menu, and it was under Reshape, and here's Intersect. And
| can go click here and then maybe type |, which is not assigned to any Command. So | can assign it and
say OK. So now if | simply type |, that intersects them. How convenient. So you may find that useful to
do. [0:02:45]

Now in terms of learning keyboard shortcuts, as | mentioned, you can learn them often by just reviewing
what it says under the menu. So for example the File menu, Open. We have Open as Command+O or
CTRL+0O. But, if we want to look at these and learn them maybe more systematically, we can go to the
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Options, Work Environment, and under the keyboard shortcuts, we can click in the - let's say | will close
this down, and now we can see the keyboard shortcut preview, and see that there's a Show Shortcut List
in Browser. [0:03:24]

And when | open that up, we will see the browser pop up within a few seconds with a complete list of all
the shortcuts including, if | do a find here for Intersect, and say next here, here is Intersect. You can see
the keyboard shortcut that | just created, the letter | is now in that list. So it's always up to date, this
shortcut list in the browser. So you may want to just look through this and see if you understand all of
them that are there or many of them. The ones that perhaps catch your eye, you can experiment with
and learn, and then gradually you will learn more of the keyboard shortcuts that will be helpful for you.
[0:04:08]

Now if you do find that there is a Command that is a little bit hard to figure out where it is, for example,
if 1 right click in empty space, there is the "Go to Last". And you can see here, last elevation - it would be
the last elevation that I've opened up. Now in this case, it's whatever was the last elevation in this
particular project file that was looked at here. So right clicking is not a very time consuming thing, but
perhaps you want to go back to last elevation frequently, so you might want to go to the Options menu,
Work Environment, Keyboard Shortcuts and find that. [0:04:46]

The last elevation, it may be hard to figure out where that keyboard shortcut is located. In other words,
| got it from the context menu rather than from the main menu. So instead of looking under the current
menu structure, | may say all Commands in alphabetical order. And then, when | change that choice, |
can scroll down and, for example, find the group that says Last here. And here's last elevation from the
context menu. And | can click and say, "Well, what if we did E?" Well, it says E is not assigned to any
Command, let me assign it. So you could do that. So now, if | go back to the floor plan with the shortcut
F2 for example, | can hit E and it will go back to that elevation. [0:05:32]

So you can choose single key shortcuts or multiple key ones. For example, like Command+E or CTRL+E
or some variation. | believe that Command+F or CTRL+E would actually be rotate, so we wouldn't want
to use that. But you might pick some combination that you could use. So let's look at some of the
common shortcuts that | find so useful, and we will just take a very quick look at each one of them. So
for example, if | want to open up a File, a new file, | can hit Command or CTRL+0, and that says Open
File. On the other hand, if | want to save the file that I've already done, | can hit Command or CTRL+S.
So those are two shortcuts that | find very primary, in fact | recommend that you save your work with
Command or CTRL+S frequently as you go along. [0:06:26]

Now if you want to print, just like most programs, Command or CTRL+P will bring up the Print dialog
box. And another one that | use all the time would be Command or CTRL+L for the Layer Settings dialog.
Now let's look at some of the operations that have to do with process. In other words, how do you
cancel or undo the process of what you've done recently? So there is a shortcut button here, of course
for undo, and this would undo the intersect or redo the intersect here. But of course there are the
keyboard shortcuts Command or CTRL+Z and Option+Command that would work. And | believe that
would be Alt+CTRL for redo. [0:07:14]

2 Best Practices Course — Week 14 Part 7 — © copyright 2012 by Eric Bobrow



Now one of the things that this does as well, if you have placed something - so let's say that | placed a
chair here and then if | undo, and | redo, you can see that it comes back in and it has handles on it. So it
has it selected. So that's a little side effect benefit of undo/redo as a combination here. Now if | want to
cancel an operation of a process, the Esc key is going to be helpful. So if | am dragging something here
and | hit the Esc key, it will cancel that operation. But the Esc key does multiple things, and it will depend
upon what you’ve got in [incomprehensible]. [0:07:57]

But let's say that | had a marquee around an area and | selected some elements perhaps inside or
outside the marquee. And then | started an operation to drag them. So I'm dragging these elements. If|
hit Esc the first time, it will cancel the operation. If | hit Esc the second time, it will deselect the
elements. If | had Esc a third time, it will remove the marquee. And a fourth time, it will remove the
toolbox, if you look on the left of your screen, from the marquee or whatever tool you're in back to the
Arrow tool. So those are four separate uses for the Esc key. And ArchiCAD will use them in that priority
order. But of course if you don't have a marquee, it will skip over that and just go to the next one, which
in many cases would be to move back to the Arrow tool. [0:08:50]

Now speaking of the Arrow tool, if we hit the letter W, it will jump back to whatever was the previous
tool. We hit W again, it will go back to the arrow. So perhaps we are in the middle drawing walls like
this, and then I hit W, I'm in the Arrow tool. | hit W again, I'm back in the Wall tool. You might find it
easy to remember that by noticing that the last letter of the word arrow is W. Now if you're drawing a
complex shape, perhaps you have a slab, and you wanted it to trace a series of points like this, and
perhaps you make a mistake, you're way off or just a little bit off of that point, you can use the Delete
key on the Mac or the Backspace key on Windows to back up one or possibly more than one step all the
way back to the beginning. So it doesn't cancel the operation, it just backs up one step at a time. It will
also be effective if you have say a series of walls that you are drawing like this, and you can go and hit
the Delete on the Mac or Backspace on Windows to go back one or more steps and perhaps continue
from whatever point you had. [0:10:06]

Now when you're drawing things, you will want to be able to put in coordinate input. So if we have the
tracker visible, then as soon as we start to draw or drag or edit something, we'll see the tracker come up
usually, and we can type in a value. And if we just type in a number, it will fill in the highlighted value,
which by default is the distance. So I'm saying how long do | want to make this wall. Let me make it 20
feet and hit the Enter key. Now, if | wanted to be specific about coordinates, then | can type in, for
example, X, and it will just expand the coordinate palette. | can say | want to go in the X direction 8 feet
and then type Y to highlight the Y value and type in -8, and that would give me something that particular
distance when | hit the Enter key and complete it. [0:11:00]

Now of course sometimes we may want to do it with the angle. So | can type in an angle, or of course |
can snap to a guideline. But | wanted it to be a specific angle, let's say this is 90 here that it is
measuring. If | wanted it to be 75, so | can just type in 75. However, when | typed in 75, it made it as the
distance. So let me just change that distance to be say 10 feet, and then hit the A to say I'd like to
highlight and control the angle. So we need to type in the letter A if want to control that. [0:11:34]
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Now if we are looking at the settings of the wall, you can see that the walls are drawn at a certain
height. It looks like the ones that I've got right now are set at a rather odd height of minus 15 feet here.
Let me just change them to zero going up to 10. And you'll notice the B and the T here. If | type the
letter B, it will highlight that. | can actually enter that, or T will highlight the upper value. So | can make
it a 12 foot high wall, and that would then, when | hit the Enter key, accept that. So now I'm drawing a
wall that, if | were to select it, you will see it's then set to a new value here. [0:12:17]

And of course if | have something selected, | can change it as well. So | can type in B or T to highlight
those values. No | go to the other tools, B and T will be available in many cases. The Door tool and the
Window tool will look for their anchor. So in other words, if the anchor for the door is the sill and we
type B, it will highlight that. T would be ignored. On the other hand, for Windows it is common that we
would anchor or make the reference point be the top, the header of the window. And the letter T will
take effect, whereas B would be ignored. Now if | go to the Roof tool, the B would highlight the value
that has an H here, which is the height of the pivot line. So B would be available for that. [0:13:04]

Now angle will not do it, let's see if we actually type a P. No, even though it says H and P, it doesn't
respect that. But B will work for the roof base of the pivot line. And as you go through these other
tools; the Shell tool may actually ignore that. It doesn't seem like B or T work. But Beams, B would be
the bottom and T would give me the top. Columns would be similar, B and T. Slabs would be similar, B
and T. So many of these would be the same. Even Stairs, bottom and top would be the same. And Mesh
and Curtain Wall. Curtain Wall does not seem to be responding there. And Objects again, we can type
in B or T to set those values. [0:14:01]

Now if we are positioning something like a wall, and let's say that | wanted to make a wall a certain
length. Let's say that | wanted it to go to a point in line with this, and | have now a guideline here. But |
wanted to take it perhaps 3 feet to the right. So you can see that the distance value is highlighted. | can
type in a number like a 3 and a +. And what happens is it takes in the number that | type in, the 3, and it
adds it to the previous value in the tracker. And this is common in any of the coordinate input that you
have in ArchiCAD, whether its distance or angle or bottom or top or X or Y, you can type in the
coordinate name. [0:14:55]

Or to highlight it, you can then type in a value and then instead of hitting Enter, you can hit a + and it will
add it to the previous value that was there before you started typing, which in this case is the location
that was in line with the initial point. Now we can also do a minus if we wanted to make it shorter. So for
example, if want to line this up with this point but make it shorter by 5 feet, | can do a 5 and then a
minus. But if you are working in U.S. standard measurements where feet and inches are used, then you
would need to say 5 foot 0 and then a minus, because it uses the same minus character as a separator
between the feet and inches, but it will still work. In fact, you can actually make a slightly shorter version
of it by saying going along here and saying 5 minus minus. So second minus, even without the zero,
would be accepted as a subtraction. [0:16:02]

Now sometimes when you are placing things -for example, we may want to place a column in a specific
location - we may want to bring up the tracker to place it. So if | hit the letter N, it will bring up the
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tracker. And | can see what the values are currently and perhaps type in a value say X20 and Y20. Now,
by hitting the letter N I'm bringing up the tracker, but it's measuring from whatever point ArchiCAD
considers the current origin. And so that was 20 feet over and 20 feet up from the most recent user
origin, which in this case was probably the project origin. [0:16:45]

If I use the Origin Placement tool and place it let's say on a corner here, then now that I've done that, if |
hit the letter N to bring up the tucker, | can be typing in a relationship to that location. So let's say |
wanted it to be X 10 feet over and Y minus 8. So that is going to be 10 feet over and 8 feet down. So by
hitting the letter N | can bring up the tracker and then use the coordinates. But in fact actually, | can just
at any point just type in a letter like X and it will bring up the tracker as well. So the tracker is the then
available for input, even if you don't type the letter N. [0:17:33]

Now, let's move on to one other shortcut here, which | find very useful, which is to create a guideline
segment. So if | have a window here and | wanted to put in another window perhaps a different size - so
| don't want to drag a copy, | want to make a window that is larger, for example, and a certain distance
from this one. Then | might actually say that I'd like to create a guideline segment from this window a
certain distance. Let's say | wanted it to be 8 feet away. | can type in a distance, hit Enter, and now you
can see the checkmark that | can hit the Enter key again. [0:18:19]

And what Enter does here is it confirms the placement of the mouse as a point for clicking. So it actually
confirms that place and does the same thing as clicking the mouse. And that will then place in this case
the window exactly that distance. Now this keyboard shortcut for create guideline segment on
Windows, | think it might Shift and tilde or backquote. On the Mac, at least in ArchiCAD 15, it's an odd
character, the section separator character, which can be typed in word processors like Microsoft Word
with the Option key and the number 6. But in ArchiCAD, because the Option key is used for doing the
parameter pickup with the eyedropper, the shortcut is not affected. And Graphisoft has acknowledged
this as an issue with ArchiCAD 15 with the standard keyboard shortcut. [0:19:23]

So what | would recommend for this particular one is to go into the keyboard shortcuts and create a
new shortcut for let's say, that would be create guideline segment. Now, if you want to jump down to
the C to be able to find it, | just typed the letter C on my keyboard while looking at it and it will jump
down to that letter. And | can go to create guideline segment, and you can see here's the shortcut. And
I might do say Shift+backquote, which is a tilde, and say assign that, and that would be then available
separately. So now if | wanted to make another different type of a window, let's say a different size
here, | can do Shift+backquote and now it's actually creating that guideline segment. So let's say |
wanted it to be 6 feet away and hit Enter to finish it and Enter to then input the placement of the corner
of the window. [0:20:29]

Now to select things, one of the most basic things that you learn in ArchiCAD is that you can use the
Arrow tool to select something and you can use the Shift key to select a second or possibly other
elements, third and fourth things. But if you're not in the Arrow tool, for example, you're in the Wall
tool or the Window tool, you can press the Shift key down and it will temporarily become an arrow. And
so the Shift key is used for that purpose as well. [0:21:01]
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Now the Shift key also is used, and this can be confusing for new users, if you wanted to stretch
something - say we use the pet palette here to stretch this. If we don't have access to the guideline, and
there are some cases where we don't, then the Shift key can be held down. And when | press the Shift
key down, it will lock it on the nearest known angle. And one of the things that ArchiCAD does is it looks
to see you when you press the Shift key down, what you are closest to. For example, am | close to this
end or the other end. So if | press down the Shift key when I'm close to the left side of this wall, | can
snap going vertically to that end, but if | press it down when I'm on the right side, it will allow me to snap
going vertically from the right end. So the edit origin is selected based on which point you are closest to
you as well as the nearest angle. And the Shift key is used for that. [0:22:00]

Now for selection of things, there are some really great shortcuts. The simplest one is to go to the Edit
menu and Select All. And you have Command+A or CTRL+A. Which, if you have a tool active, for
example, it will select all of the elements of that type like select all windows. If | have the Wall tool
active, and | do Command+A, it will select all walls. You can see as | zoom out that it's selected all the
walls. Orif | have the Arrow tool, Command+A will select everything that it can on the project floor
plan. If | have a marquee active and | draw a box around things, then Command+A with the Arrow tool
will select everything that is within that, or touching within it. [0:22:45]

If 1 go to a particular tool such as the Column tool, then it will select all of the columns within that
marquee. So that same shortcut, Command+A or CTRL+A has a few different variations, but very
powerful. Now you can also bring up the Find and Select command here using Command+F or CTRL+F.
So very easy to remember. Command+F brings up Find and Select, and then we can say what we want
to select. Do | want to select all elements and say plus? That will just get everything. Or do | want to get
all. 3D elements or all 2D elements or be more specific about Find and Select, because there's many
different options there. Find and select is a very powerful tool that | often use the shortcut for.
[0:23:36]

Now if we are selecting things and we are wanting to select a specific element, for example, I'm going to
the corner here, it's highlighting preselection before | select a wall. But perhaps | want to select a
different wall. | can use the Tab key to cycle between one or another of these. And in fact, if | have
multiple elements, three or four elements, it will cycle through all of them. [0:24:02]

Now the space bar is an interesting tool because the space bar - let's say that | have the Slab tool active,
it will draw a slab if it can. Whatever tool is active. So it is the Magic Wand, and | can go then go and,
for example, click on this and what it did was it created a slab. There's now a slab that followed that
wall outline. If | did it on an area where this outline is a little bit odd, it will allow me to keep this, but it
actually did just part of the walls that it was intersecting because this was an odd shape here. So the
space bar will bring up the Magic Wand like this in many cases if you're in a drawing tool that will allow
multiple points to be input. [0:24:51]

It won't work if you have the Object tool for example, because the Object usually only has an insertion
point and possibly a rotation or size that you are going to click on. Now the other thing about the space
bar is the Arrow tool has the option of selecting things when you are in the middle of them, and that is
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the Quick Select. So if | click here in the middle of this window, it will select it. It's because of this
magnet. Now if | turn off the magnet and | go and click in that same place, it will not select it. Perhaps if
| go along and basically draw a selection marquee around it, it will select the elements that it
overlapped, in this case, the wall and the slab. [0:25:33]

Now if | wanted to turn on or off this Quick Select on the fly, | can press the space bar or release it and it
will toggle that Quick Select state. Now sometimes you want to have elements grouped, and so it's good
to know the shortcut for grouping things. So let's say that | press down the space bar to turn off Quick
Select, and | then draw a marquee around these elements in the center area of this building. And then |
can use the Edit, Grouping, Group or Command+G or CTRL+G. And these elements are now grouped
and the shortcut for ungrouping them if | want would be Option+Command+G or Alt+CTRL+G, and you
can see when | do that, these elements are still selected, but they are no longer grouped. [0:26:26]

And if they are grouped here, like if | group them again, what that means is if | select any one of them, |
select all of them. But if we want to have groups suspended, which is available from this toolbar item,
then | can select an individual item and move, delete or change it without affecting the rest of the
group. This suspend groups is available as a shortcut with just a simple Option+G or Alt+G. And you can
see when | click on that, it changed the state of the groups to be active. And so with one element
selected, all of the rest of the group then immediately became selected. [0:27:10]

Now if we do have a number of elements selected like this, we can change the settings for an element
by clicking in the Info box. Now in this case it's selected several walls and the chair, and when I click on
the Info box for the element that is highlighted with is a wall, it's going to change the settings of the four
walls, possibly changing the layer or other settings relating to walls specifically. Now if | wanted to do
that more quickly, | can use Command or CTRL+T, which will bring up the same thing. It will bring up the
element settings that are currently showing in the Info box. This is available under the Edit menu,
Element Settings. And it shows up with whatever the name is, Wall selection settings or it would be
Object selection settings or Wall Default settings. [0:28:06]

In fact, if | have nothing selected, then if | have, for example, the Wall tool active, this Edit Element
settings would say Wall Default settings. So it will be whatever element type it is. If | have the Window
tool selected, Command+T will bring up the Window Default settings. Now if we wanted to affect
multiple types of elements, for example, if | wanted to affect all of these elements that I've got
highlighted, which are walls, chairs, and some columns, | can't do it by just clicking on the Info box, and |
can't do it by doing the Command+T or CTR+T. But | can do it by going to the Edit menu, Element
Settings, Edit Selection Set, which has a shortcut of Command+Option+T or CTRL+Alt+T. [0:28:57]

That allows me to change the color or the layer or certain other attributes of all the elements, possibly
putting them all onto a new layer to hide them or to categorize them in some way. And so if | do
Command+Option+T, it will do that Edit Selection Set. Another way is that you can actually, with
multiple elements selected, you can click on this button immediately to the left of the Layer popup and
it will bring up Edit Selection Set. So that is a special mouse click that becomes available when certain
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elements are selected. When no elements are selected and I'm in a tool, this same button becomes the
Layer Settings dialog. So that button changes its state. [0:29:40]

Now if | want to switch tools, | can use the eyedropper. So the eyedropper is available from the toolbar
here, pickup parameters or the syringe with inject parameters. But | can also just press down the Alt key
or the Option key and get the eyedropper and then switch for example to the Object tool, where | am
prepared to put in an object like what | just highlighted which was the chair or use the eyedropper to
pick up the Column tool and now I'm prepared to put in a column. [0:30:14]

Now if | want to pick up the settings of an element like the window and then inject it into another
element, | can use the syringe, which would be Alt+CTRL or Option+Command, and then | can click and
affect the other element with that. Now sometimes we want to be able to switch from one type of
element, like this window, to another type of an element for the window. So if | look at the preview of
this window here, we'll see that it's got a certain size and it may have some other parameters that have
been set custom. If | click on another type of window, let's say the one next to it here, you see how it
totally changed its size as well as perhaps other parameters. [0:31:05]

Now what I'll do is cancel out of this and I'll go back in, and instead of just clicking on this, | will hold
down the syringe shortcut keys, Option+Command or Alt+CTRL, and then click on the new part, and it
has successfully switched to the new, in this case window part. But it maintained the size and any other
parameters, for example, the color of the frame or the width of the casing or whether or not it has assill
and things like that. So that is parameter transfer using the Syringe tool within the library part using the
keyboard shortcut Option+Command or Alt+CTRL and then clicking on the parts. [0:31:49]

So if | actually activate that, we'll just pick perhaps say a different type of window like a slider here. And
| select that. Now you can see how it kept the same size, but switched to a new window style. Now
basic shortcuts, as | went over for drag and rotate and mirror, are one of the most common things that
we might learn in ArchiCAD. So under the Edit menu, Move; we have Drag, Rotate and Mirror with
Command or CTRL+D, E, and M. And then if you want to move something up or down, you can elevate it
using Command or CTRL+9. Now | do remember and use all the time Drag, Rotate, and Mirror. | don't
do Elevate very much, so | just will do that from the menu. [0:32:46]

And drag a copy, | prefer actually to just press and release the Option or CTRL key while dragging in
order to make it a copy. So all of these are certainly useful to know about, and it's really your choice
which ones you take advantage of. Now one thing that | often do from the menu is | right click and
choose something like Multiply. But in fact, it's much quicker to do CTRL or Command+U to get that. So
if I cancel this, if | do Command+U, you can see how that comes up much quicker. [0:33:26]

Now if | wanted to adjust some of these elements, and let me just suspend groups here so | can affect
them individually, | can select one or possibly more than one wall here. And there is the option to adjust
here. And so | can say | would like to adjust it to meet the other wall. And | will just undo that. Now the
Adjust command can be triggered by holding down the Command key or CTRL key and typing a minus or
a dash. And it gives the same command to adjust. Now you'll notice that the three walls extended to
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meet the other one. This one below was - if it were extended it would never meet, because the other
wall is not long enough. So it only does the ones that are able to meet the edge that was clicked on.
[0:34:35]

But you can do Command dash or CTRL dash or minus, and that will give you the adjust. Now if we have
elements that are sticking out like this, | can trim them. And so there is the Trim command here with
the scissors. And | can click on that and then click on the edge of this piece to trim it. And | can actually
do that with pieces that stick out, perhaps get rid of them entirely if they are attached to something
else. Now a shortcut is, instead of having to go up here every time, is to the simply press down the
Command or CTRL key to get the scissors and then you can literally just go in and delete these elements
here. [0:35:22]

Now it won't work on a freestanding element. If | click on this, because it's not attached to anything it
will not actually remove it. And the other thing is you can't have anything selected when you do that.
You have to have nothing selected. But holding down the Command or CTRL key will bring up the
scissors icon. [0:35:40]

Now the Command or CTRL+click actually does many different things, depending upon the context. For
example, | have the Wall tool active and | select one or more walls, | can actually Command+click or
CTRL+click on the edge of another wall, and it will extend it to meet that wall. Much the same way, the
same Command is the same as the Adjust command. Now interestingly, if | have another tool active,
let's say the Beam tool, and | select a wall and | hold down the same key, which is the Command key and
then click, it will not do it. In this case, it actually just deleted that because it was trimming it. [0:36:32]

But in some cases, | guess if | have the Arrow tool active, and | do this - no it still works. There was an
older style of shortcut in ArchiCAD where you can click and get a hot spot projected. | suppose if we
activated the Hotspot tool - which for those of you who don't know it, you can place hotspots anywhere
you like. You can measure where there are going to be, and then they can be snapped to. You can see
how the checkmark happens in the same way as the end of an element. Now if | have the Wall tool
active, and | Command-+click or CTRL+click on this wall, you can see it projects a hotspot onto it. So | can
select this wall and project a hotspot onto it. So now | can see where this would meet, even though it's
not actually extending to meet it. [0:37:26]

Now we can also use that Command or CTRL+click for other things. So for example, if | have the
Dimension tool active and | say dimension a few elements here, and then finish putting in this dimension
and then realize, "Oops. | needed to dimension to the center of this other window." | can select the
dimension chain and Command or CTRL click on for example the center point of this window and that
will add that point to the dimension chain. | can do it repeatedly. For example, | can add another
reference either in the middle of that chain or potentially to extend the chain. So it will just keep on
adding points to the dimension chain by Command or CTRL+clicking on it. [0:38:22]

Now let's go onto some keyboard shortcuts for navigation. We are in the floor plan. If | hit F3, it will go
to the 3D window. If | hit F2, it will go back to the floor plan. Now the 3D window can be viewed in
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different ways. When | hit say Command+F3, it will go to one style, which in this case we'll see is an
axonometric view. And when | do instead of Command+F3, | do Alt or Option+F3, and I'm in
perspective. And you can see there is foreshortening. Let me just rotate this around. So Command+F3
gives me the AXO view, and Option+F3 gives me the perspective, or CTRL and Alt would alternate
between those. [0:39:21]

Now | will go back to the floor plan, hitting F2, and | will draw a marquee around this area. And if | want
to look at just what I've selected in 3D, | can right click and say Show Selection or Marquee in 3D. But
there's a shortcut. On Mac it's F4, on Windows it would be F5. So | can go back to the floor plan with F2
and hit, for example, if | just draw a different marquee like this one, | can hit F4 and it will show that
particular view that I've got. Now there is a shortcut where there is an option under the context menu
to Show All in 3D, which is Command F4 or | assume it would be CTRL F5 on Windows. And that is
effective in both plan as well as in the 3D window to restore the rest of the currently visible model
elements into the 3D view. [0:40:18]

Now as | mentioned earlier, we could setup the keyboard shortcuts to go to different parts of the
project. So for example, if | have been looking at sections - and in fact, | don't have a section, so let me
just quickly draw a section through this area. And then I right click on that section marker and say open
the section here. Now if | go F2, | will be back on the floor plan, and if | hit F6, | will be back in that
section because if | right click, you will see under Go To, Last Section has a built in shortcut for F6. And |
have created a shortcut earlier for Last Elevation which is E, but Last Layout is a nice one as well,
because it will go to the last layout that you were looking at. So you can go to the floor plan, for
example, hit F2, hit F7 to go to the last layout. [0:41:18]

Now when you're in a view like this here, if you want to Fit in Window of course there's the option to
click this little icon here and Fit in Window. And if you use this icon for previous view, you can go back
to the last view you were in or perhaps even more different views that you were looking at. Now there
are keyboard shortcuts for all of these. So Command+quote or CTRL+quote will go to Fit in Window and
Command or CTRL+left bracket will go to the previous view. You can do that multiple times. It will go
through each of those views that you had. And right bracket, Command or CTRL+right bracket, will give
you the next view in the sequence. [0:42:04]

Now what | find particularly useful here is let's say that | zoom in on this area and | was working on this
area, and then | zoom out, and then | want to be looking at a different area on screen. So now | can do,
with the shortcut Command or CTRL+left bracket twice, and I'm in this corner of the building, Command
or CTRL+right bracket twice and I'm in the other area of the building. So it can be very quick for
navigating around. [0:42:32]

Now sometimes we may want to zoom in on an area, and we want to just select some things. And so for
example, | may select just a few elements here and then use the shortcut under the View menu, Zoom
that says Zoom to Selection, which has a shortcut of Shift+Command+quote or Shift+CTRL+quote. So
that will jump in here. So | do Command+quote, it will jump out to show the whole thing,
Shift+Command+quote will jump in to show just the elements that I've got selected here. [0:43:09]
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Now sometimes we are looking on different stories, and we want to go up or down a story. So of course
we can go into the View Map and double click on another story here. | can go up and down there. |
could be in the Project Map and do a similar thing. Now sometimes, when we're on another story, we
want to have a Trace Reference of the lower story, or another story here. So we can see this in a ghost
image and draw on top of it. Let me just change my, in the Trace and Reference here, let me just change
the reference to a red color so we can see it more clearly there. [0:43:56]

Now | can go up and down stories by using what I've mentioned in the Project Map or View Map and |
can also go into the little popup in the toolbar that allows me to select a story. And | can also use go up
and down a story in that toolbar, and there are some shortcuts here. But | find these a little bit
awkward to memorize. And so what I've realized is that there was still a shortcut available going up and
down a story that came from a long time ago with ArchiCAD, and that is holding down the Command or
CTRL key and typing the up arrow or the down arrow. So Command or CTRL down arrow or up arrow.
[0:44:37]

Now that actually switched the stories, but it didn't switch the Trace and Reference. Now let me just
draw something with the Wall tool here. Perhaps I'll just draw a Trace and Reference of just the main
part of the building that I've got. And so we can see the difference. And | will just make the reference
perhaps a different color, so we can see that standing out in a relationship here. And so now, if | want to
turn the Trace and Reference on or off, you can turn it on or off using this button here, but there is a
shortcut for doing that. And that shortcut is Shift+F2. So F2 takes you to the floor plan from any other
view, Shift+F2 will turn on or off the Trace. [0:45:43]

So we can go up or down with the Command or CTRL down arrow or up arrow, and we can turn on or off
the Trace with the Shift+F2. So those are some shortcuts that you may find very useful for the plan.

Now let me go down to the lower story and zoom in on this area. Sometimes we want to be able to
switch between hairline view under the View menu and True Line Weight. Now there is no keyboard
shortcut available there. At least by default. So we may want to go into the Options, Work
Environment, Keyboard Shortcuts. And let's go to the Command that says True Line Weight and perhaps
give it a shortcut key. [0:46:37]

Now true line weight starts with a T, but T is used for the top elevation. So | might want to switch it to H
for hairline to switch hairline off and on. Now it conflicts with home story, which is a shortcut I've never
used. So I'm going to assume that if I've never used it, | don't need it. So I'm going to overwrite it, and
this is an option that you have any time you want to actually take over a keyboard shortcut from
something else, if you prefer, you can set that up. So now, if | hit the H key you can see how it will cycle
back and forth between hairline and true line weight. [0:47:14]

Now one of the most basic navigation tools within ArchiCAD is the pan tool. So if | click on the hand and
click and click, I've now moved the view over. But | can also press the center mouse button and do the
same thing. And when | release it, we're in a new position. Now if you're using the Apple Magic Mouse,
which | am, there are no buttons on it. And it automatically has sensitivity to the left side and the right
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site so that you can set up one of those sides, usually the right, to give you the context menu. If you are
left handed person you might want to do it the reverse. [0:47:55]

Now the center mouse button doesn't exist on a magic mouse, however, you can use a tool called Magic
Prefs. So if we go to the Apple menu, System Preferences, you'll see that there is a tool that I've
installed here that is - let's see where is it, Magic Prefs, and Magic Prefs allows me to setup for example
the shortcut for the "one finger middle access click", which basically means if | press down somewhere
in this general area, it will do a middle click of the mouse. So Magic Prefs is a free tool, you can just
Google it and install it, and then your magic mouse will give you the ability to pan the same way you
would with a standard mouse. [0:48:46]

Now another shortcut that relates to this, if | go to 3D, is that if | press down the center mouse button |
can pan around, but if | add the Shift key at the same time it brings up the Orbit. And | can orbit
wherever | want and when | let go it takes me out of that mode. So it's much faster | find then clicking
on the Orbit, rotating this around, and then having to click again on the Orbit. Although there is also the
shortcut available of hitting the O key, which will orbit. And then you can hit O again to get out of it or
the Esc key. But | find I'm just so often panning around and then using the Shift key, and | can orbit, and
just let go and I'm done. [0:49:30]

Now in terms of other navigation Options, if | use the cursor keys, for example, the up or down or left or
right arrows, without any other key like not using the Command or CTRL or any other key, then it will
scroll. So left arrow will scroll me to the left, up arrow will scroll me up. So you may find that just
nudging your view a little bit is useful by just pressing those cursor keys down. Now on the other hand -
| will just zoom out a little bit - sometimes you may want to position furniture or text just a little bit one
way or another, so you might want to nudge it. And it can be easier to do this using the shortcut that is
built in, and that is for the nudge, you can hold down the Shift key and use one of the cursor keys. In
other words, Shift up will move this a little bit up. You can see how I'm nudging it just a little bit.
[0:50:43]

And perhaps | take it to the right with shift to the right. So shift and whatever cursor key. If you want to
move a larger amount you can hold down Shift and Alt or Option and then do the key, and then it will
jump a larger amount. You can see. So you can move things around pretty quickly onscreen just using
the keystrokes, other Shift and the cursor keys for small nudge, or Shift and Option or Shift+Alt and a
cursor key for a larger nudge. [0:51:10]

Now the settings for the distance is set under the View menu, and this would be under grid Options,
grids and background, and the main grid size, where you would see the little graph paper, grid lines, that
is the larger nudge. and the construction or snap grid is used for the small nudge. So you can set those
to whatever values you find useful. [0:51:35]

Now one final navigation using the cursor keys is if you are in the Layout book, for example, here; and
you hold down the Option or Alt key, you can use the left or right keys to move to previous or next
Layout. So you can see as | do that how it is moving through the layout book. And you can see it is
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changing in the navigator as well as the number down below here. Right now we're on page 2 of 7, and |
can go to page 3 by holding down the Option or Alt key and typing the right arrow. [0:52:15]

Now let's go back to the floor plan. There is an Option of using a grid in ArchiCAD. So if | turn on the grid
snap and work with the Wall tool, then I'm drawing walls or elements that are following the grid
division. So | can perhaps sketch things to nice even measurements. Sometimes this can be very
convenient to do that. Now the grid can be turned on or off using the toolbar, and it does have a
keyboard shortcut, which yes, you can see in the prompt is Shift+S. So if | hit Shift+S, it will turn off the
grid, and if | hit Shift+S again it will turn on the grid. You can see how that state changed. [0:53:02]

In versions of ArchiCAD up to a certain point, the shortcut was the letter S, which could easily be
triggered by accident. And so | think at a certain point Graphisoft changed the default to hold be the
Shift+S which would be less frequently done accidentally. Now to measure how long something is, we
have the Measure tool. And we can click any time on the Measure tool and start a measurement
process. And we can complete that measurement at any point by hitting the Esc key or the letter that is
the shortcut. In fact, the letter to do the Measure tool or measure action is M. And when | press that, it
starts the measure action. And so | can actually see those distances, and hitting the letter M again would
turn that off. [0:53:51]

Now sometimes we're drawing elements or stretching them along a certain angle. And let's just say we
want to perhaps line things up in a certain way. So for example, if | wanted to take this wall that is on
this particular angle and stretch it in line, | can press the Shift key. And this now allows me to constrain
it. Now if | wanted to stop in line with this other wall, | could move my mouse while the Shift key was
held down, and it would snap to it. However, you can see that the snap is perpendicular to the walls
angle that it is constrained to. But that is not perhaps | want. | want it to be horizontally aligned. So
while the Shift key is held down, | can press the Q and it will cycle through vertical and then horizontal,
and back to perpendicular constraint. So you can see the dotted line switch. [0:54:53]

The vertical one is quite crazy because it's offscreen. But if | hit Q again you can see the horizontal
constraint. And now when | click the mouse I've made this wall stop exactly in line horizontally with the
other wall that | was interested in. So Shift constrains it and hitting the Q one or more times will cycle
between the different cursor snap variations. Now sometimes when we are working we're using the pet
palette to adjust the shape of placement something.

So for example, if | go to the Slab tool and | select this slab, | can go and choose for example that I'd like
to offset an edge here. But sometimes I'd like to change my mind about this. Maybe | want to curve it.
And if this pet palette is off at a distance, it can take a little bit of time or just be a little annoying. So
there is a shortcut that allows you to flick between the options here, and it’s the letter F. So you can see
how the pet palette option changes to different versions. If | hit Shift+F, it goes back the other way. So
depending upon which one you want, you may find that hitting F or Shift+F well just speedily change
that choice that is currently active in the pet palette to use a different choice. [0:56:20]
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So it has to be while the pet palette is active and you press F or Shift+F to cycle through the different
Options in the pet palette. Now our final point that I'm going to bring up here is some special mouse
clicks that can be a real time saver. So everyone knows that you can click on the magnifying glass and
zoom in on an area, but not everyone remembers that if you double click on the plus, it will zoom in to
twice that scale, basically to double the magnification with the same center. And if | double click on the
minus, it will do the inverse. So if can be a very quick way to go out just a little bit to make more room or
to zoom in just a little bit. [0:57:11]

Now another special keyboard shortcut option is if | go to bring up the Favorites palette. So if | go to the
palettes under the Window menu, Palettes, Favorites, there are different options. Let me just go to the
Wall tool. and let's say that | double click on a favorite. So the Favorites palette is very powerful, and |
can go and say that I'd like to put in a wall of a certain type. Now by double clicking, | actually activated
a tool to that setting, but not everyone knows that you can actually select one or more walls in this case.
And double click on the favorite and it will actually inject it much like the syringe into that element. So
selecting one or more elements and then double clicking on the favorites will change their settings.
[0:58:11]

Now here is another shortcut that people don't realize. Sometimes we are in a tool like the Window
tool, and we may want to switch to a different type of window. We can actually click on the Flick button
here to go to the next library part. You can see we had casement, now we have casement with awning
of certain types, and here's casement with fixed. And we keep flicking through these until perhaps we
find the type of window. Here is a double casement that | want. So this one would be a casement
window with two different sashes. So | can just flick through this. It will work also with the Object tool.
So for example, I've got a particular chair and | can flick to a different type of chair, perhaps | know that |
like Armchair 4. And that's a different type of chair. So we can flick through it. [0:59:04]

Now as a side effect, whenever you flick to a different part, it will pick up the default settings of that
part, and then you're putting in the part just the way that ArchiCAD had it set up in the library. And that
means that if you have changed the settings, for example, if | made this chair, let's just say that | made it
much bigger, and | wanted to return it to its original settings, perhaps because | am getting an error
message. This is a good thing to know, if you are getting an error message, maybe want you want to do
is select the element, flick it to a different one, and then flick it back to the one that it was. And by doing
that, it will set it to the standard or default settings, and you can then adjust it as you want. But at least
you've gotten it back to the standard settings. [0:59:57]

Now another thing that sometimes people forget is there is that if | have a window or a door and | want
to put in an empty opening of a similar size or change a window or a door to an empty opening, there is
this button here that is to use an empty hole. And you can see it retained the same size, but now this is
an empty window of the same of the same size and positioning. Or of course, | could say eyedrop this to
pick up the settings, and now | have nothing selected. And | can click on the empty hole and it will be a
similar sized window opening, an empty window there. [1:00:43]
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Now the final shortcut | will just show you is that if | have a slab selected or any polygon element like -
you could have a mesh or a roof or things, we can create a hole if the tool is active that owns this. So
what | mean by that is if the Slab tool is active in the toolbox and | have a slab selected, | can create a
hole simply by clicking inside it. And so you see that actually created a hole. | did not have to do the
Boolean subtraction. Now | could make a rectangular hole if the geometry setting was such. And so now
| can go and two clicks will create a single hole here. So that’s a little bit quicker. [1:01:32]

Now another thing that people don't necessarily remember or realize is that if | want to move a hole, it's
very easy. The way to do is | deselect everything, perhaps get rid of the marquee by hitting the Esc key,
and now | want to select just the hole. To do that, | use the arrow or the Shift key and select the edge of
the hole. So I click on that and that selects in this case the hole rather than the slab with the hole. And
then | can drag this into a new position, or even just hit the Delete key. And when | do that, you can see
the hole disappeared. And what ArchiCAD did is it actually selected a different hole, just to maybe give
me a visual indication that | didn't delete a separate element, | deleted a hole in the larger element.
[1:02:21]

Let's just try deleting this hole that I've got selected, and you can see now it's put a handle on the actual
slab, just so | can see that it was not a separate element, it was a part of this main element. And I'll
undo back so | have these holes still available, and let's just look at the thing that will not select them,
that is if | have the Arrow tool or Shift key, and | click on the corner of a hole, it will select only the hole,
that in fact, the entire element and all the other holes. So to select a hole by itself, we need to Shift or
arrow click the edge of a hole and then we can select it for movement possibly to drag it delete or even
drag a copy can work in many cases. [1:03:09]

So this completes the ArchiCAD tutorial training on keyboard shortcuts that are the most powerful and
frequently used in my opinion as well as some special mouse clicks that | think are very useful to
remember. This has been Eric Bobrow, please add your comments and questions to the page where this
tutorial is posted. Thanks for watching.

[END OF AUDIO 1:03:42]

15 Best Practices Course — Week 14 Part 7 — © copyright 2012 by Eric Bobrow



